
 

 
IEC ACADEMY WEBINAR Q&A 

 
 The new IEC Standards Template – Introduction and best practice, 20 October 2020  

Questions Answers 

GENERAL QUESTIONS (where to download, when to use, etc.) 

Where can we download this IEC template as well as the 
relevant User's Guide? 

Are there any written instructions? 

The IEC template and its accompanying guide are 
available here: 

https://www.iec.ch/standardsdev/resources/draftingpublic
ations/writing_formatting/IEC_template/ 

Are we expected to update under development documents 
also using the new template? 

Nearly all the styles in the new template exist in the old 
template. So switching to the new template should not 
cause any major issues to the text itself. 

However, the new template contains a new foreword text 
and simplifies some tasks, such as the insertion of cross-
references. Therefore, it is in your interest to attach the 
new template. 

In any case, the new template will be attached when the 
document is formatted and edited at CDV stage, and the 
new foreword text will be inserted if required. 

How can I get the “IEC tools”? 

Go to the following page to download the IEC template, 
which contains the IEC tools tab, and also to download 
the guide, which contains instructions on how to install the 
template file: 

https://www.iec.ch/standardsdev/resources/draftingpublica
tions/writing_formatting/IEC_template/ 

 

The MathType preferences file is available on this page: 

https://www.iec.ch/standardsdev/resources/draftingpublica
tions/writing_formatting/IEC_rules/equations.htm 

 

It is recommended to check occasionally for updates. 

How to migrate an existing document using the present 
template to this new template, which is much more powerful 
and friendly/useful? 

Please follow the instructions in 4.3 of the user guide to 
attach the template to an existing document, which is 
available here: 

https://www.iec.ch/standardsdev/resources/draftingpublica
tions/writing_formatting/IEC_template/iec_template.htm 

When revising an old standard, may we continue to use the 
previous template that was employed when drafting the 
original standard? 

Theoretically, yes. However, the new template contains 
the up-to-date forewords and other boilerplate texts. 
Additionally, the new template will be attached when the 
document arrives for layout and editing at the central 
office. Therefore, it is strongly recommended to use the 
new template. 

When will the new template be mandatory? I sent an FDIS 
in September, so should I provide a new document with the 
new template? 

No need to provide any new files. The central office will 
take care of any irregularities; there is no need for authors 
to be overly concerned by which template is used. 

Because the new template contains new useful features 
and the updated boilerplate texts, it is in your interest to 
use it as soon as possible. Submitting files that were 
created with the help of the old template will not cause 
any problems. 
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If you save the template in your own Word default folder, 
will there not be an issue if then edited by another person 
on his/her own PC? 

No. However, it is recommended that the person receiving 
the file download and install the template if significant 
modification is planned to ensure that the correct styles 
are used and applied correctly. 

It seems that the patent text in the Introduction is in conflict 
with Note 9 in the Foreword 

It has been decided to leave note 9 in the foreword when 
patents are present. 

Is it possible to rework an existing document using this new 
tab?  

With an existing text, how do you transfer from the old 
template to the new one? Any special things to do? 

How will existing documents be converted to make use of 
the features in the new template? 

Follow the instructions for attaching the template in the 
guide available here: 

https://www.iec.ch/standardsdev/resources/draftingpublica
tions/writing_formatting/IEC_template/ 

or the instructions given in the webinar, available here: 

https://www.iec.ch/academy/?ref=menu 

There are no further special steps to take, but you may 
have to apply the style Inline equation to any paragraphs 
that contain equations within sentences. Otherwise, you 
might only see part of the equation. 

For which versions of Word is this template applicable? 

What versions of MS Word are required please? 

Word 365 version updates every 3 months 

This template should work with all versions of Word that 
are compatible with dotm files, which means Word 2007 
and later. 

Does the IEC tools feature and template work with the 
online version of Word (Office.com)? 

No. It is not currently possible to add a custom template 
to the online version of Word. 

Does it work on non-English version of MS-Word? 

It should work on any language version; it has been 
tested with French and German versions and everything 
seems to work as intended. 

One thing to note though: the sequence names for tables 
and figures need to be in English for the auto cross-
references tool to work properly. If you insert tables and 
figures by using the IEC tools tab, you should not have 
any problems. 

Does it work for bilingual documents? (one language on 
odd pages and other on even pages) 

It has not been designed for this because IEC documents 
are not presented in that manner. There appears to be no 
simple way to do this in Word. 

IEC Standard Template, page 1, second red framed box: 
The styles are not visible in the IEC tools tab before clicking 
on the Apply styles Group drop down arrow. This should be 
mentioned in the text in order to prevent people from giving 
up. 

On screen resolutions of 1920 × 1080, all groups are fully 
visible. On lower resolutions, groups are condensed, 
starting from the right, so the Apply styles group is the 
first to close up. Because it makes sense for the styles to 
always be visible, it might make sense to move the Insert 
boilerplate text and Document setup groups to the right-
hand end. 

If you have any comments or suggestions, please send 
them to layout@iec.ch. 

If you like, you can modify the tab to your liking using the 
"Custom UI Editor for Microsoft Office" freely available 
online. Basic XML knowledge required. 

USE OF STYLES 

Why did you change the bold style to strong for example? Use the style Strong for bold type, and the style Emphasis 
for italic type. 

Is it a problem if we add macros and styles in the 
documents in addition to the IEC template? 

You should try to only use the available styles. If this is not 
possible, you need to contact us at layout@iec.ch to let us 
know that you are using special styles. If you don't, we 
might not notice they are there, or assume that you simply 
formatted your text incorrectly, and content formatted with 
your bespoke style could end up being incorrectly 
formatted. The bottom line is, please contact us if you 
need to use bespoke styles and/or macros. 
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Do we have a "Title Style"? The style of the main title of the document is MAIN-TITLE. 

Can you demonstrate remove styles, remove formatting? 

The "Remove formatting" button removes all formatting in 
the selected text; it resets to Word's built -in Normal style. 
An IEC style needs to be applied after removing 
formatting. 

I have used the tool once recently but could not find the 
formatting tool for NOTE. I am using word for Mac IoS.  
Would you have some recommendations about this?  

I'm afraid we cannot provide assistance for users of Macs. 
However, most of the tab seems to work OK, with the 
notable exception of the Insert term button. 

In this case, the alternative is to find the style called Note 
in the list of styles, either on the Home tab, or by clicking 
on the Other styles button in the Apply styles group. 

How to include a piece of text that was typed by an expert 
without the template in a text using the template? 

Simply paste the text into your document and use the 
Apply styles group to apply the correct styles to the pasted 
text. 

NUMBERING 

Does the renumbering work also on terms, if you add a new 
one between two existing terms? 

Yes, the terms numbers will be update automatically and 
instantaneously; no need to update manually with F9. 
They are numbered in a similar way to heading numbers, 
which are also updated automatically without any user 
intervention. 

How do you update the figure numbers? 

The simplest way is to select the entire document (Ctrl + 
A) and press F9, which will also ensure that any cross-
references to the figures are also updated in the text. 

You can also update individual numbers by placing the 
cursor on the number field and pressing F9. 

Where to select the heading level 1, 2, 3? 
In the Apply styles group, click on the drop-down 
Headings menu and select the required level. The 
appropriate number will be automatically inserted. 

In a document, can we make the first annex other than A? 
Yes. Right-click on the annex heading and click "Set 
numbering value". Set the letter of your choice. You may 
have to reapply the style Annex-title for this to work. 

Is there a way to sort and renumber terms? For example 
after a new term has been added but you want them in 
alphabetical order? 

If you move terms about, they will be renumbered 
automatically. 

Terms should not be listed alphabetically, but by concept. 
One reason being that terms that are in alphabetical order 
in one language are unlikely to be in the same order when 
translated. 

What about numbering of "notes"? same as for e.g. tables? 

From 24.3 of the ISO/IEC Directives Part 2:2018: 

Within a given clause or subclause, notes shall be 
numbered sequentially. The numbering restarts at each 
new subdivision. A single note in a subdivision does not 
need to be numbered.  

Can the numbering of the annex letter in 
equations/tables/figures be automatic, i.e. B.1? This would 
simplify work a lot if an additional annex is inserted before 
an additional one. 

This has been looked into. It is theoretically possible to do 
this. However, the changes required to the template would 
make it incompatible with existing documents. Therefore, 
there are no plans to implement this. 

How many levels of title or paragraph numbered are 
available? I can need up to 6... It just so happens that there are 6 levels. 

If the number of the scope is not 1., but 100.1, what is the 
appropriate way to change this number? 

Right-click on the 1 of Scope, and in the menu that 
appears, click on "Set Numbering Value…". Set value to 
100 (in this case, with "start new list" selected), and click 
OK. 

How to use the template for an amendment where the 
numbering is not necessarily contiguous? 

To number clauses and subclauses in amendments, use 
the amendment heading styles. See Clause B.8 in the 
guide. 



How do we insert a Figure in Annex B? Please see 6.4.2 of the user guide. 

SHORTCUTS 

If you are in the table of contents and you click on a 
reference to say, Table 1, is there a way at the location of 
that table to insert a link "back to the top" to return to where 
you were in the table of contents? 

Yes, press Alt + left arrow key. 

Could you point out to the keys to be pressed to have a 
quick access to the field code behind Figure title A.1? 

To view the code of a specific field, right-click on the left-
hand side of the field to view the floating menu, and click 
"Edit Field…". 

To view all fields of the document within the text of the 
document, press Alt + F9. 

CROSS-REFERENCES 

If an auto cross-reference is inserted to a figure that does 
not exist, and the figure is subsequently added, does the 
cross-reference automatically update when F9 is used or 
does the cross-reference need to be re-inserted? 

A dynamic cross-reference can only be inserted if the 
element being referred to exists. If you attempt to refer to 
a figure that has not yet been created by using the auto 
cross-reference tool, the text you selected will be 
highlighted in red, which indicates that the figure has not 
been found and no dynamic cross-reference field will be 
inserted. Therefore, you will have to wait until the figure is 
inserted before you create the dynamic cross-reference. 

Cross-reference: my experience is that the automatically 
set cross-references are typically hard to handle as they 
apparently sometimes get invalid when working with the 
document. They can change into an "Error - invalid cross 
reference", "1.1.1.1." or simply "0". Are there any updates 
or hints to handle this better? 

When cross-references become invalid, it is usually 
because the element being referred to has been modified 
or renamed. For instance, if you refer to Clause 10 in the 
text of your document, but then totally rename the heading 
of Clause 10, the bookmark used to refer to Clause 10 is 
also likely to be deleted, which will then lead to a "Error! 
Reference source not found." 

Therefore, avoid completely changing elements of the text 
that are referred to in the text. 

Can you "select all" and click "Auto cross-reference"? 

No. While it is possible to have Word search and replace 
static text with dynamic cross-references automatically, it 
is not 100% reliable. This solution offers the best 
compromise between simplicity and efficacy. 

If we give a Code number to a Test, when the clause 
number of the Test changes, the Code number stays. Can 
we use cross-reference to this Code number? 

The Code number example: IEC 61730-2:2016   

10.10 Cut susceptibility test MST 12  

Here "MST 12" is the Code number I refer to. 

You can, but you will need to use bookmarks to 
accomplish this. In this case, select "MST 12" in the 
heading of 10.10, click on Bookmark in the Insert tab, give 
your bookmark a name (e.g. MST12). Then, using Word's 
cross-reference tool (available in the Insert elements 
group of the IEC tools tab), select Bookmark as the 
reference type, Insert reference to: Bookmark text, click 
on MST12, and Insert. The cross-reference that you just 
created will always direct the reader to the relevant 
heading. 

Is it possible to change the default value of the “cross-
refence” – “Insert reference to:” to the typical entry: e.g. 
“only label and number”? 

Yes. See 6.6 in the user guide. 

  



EQUATIONS AND MATHTYPE 

In applying the template I receive a Visual Basic Runtime 
Error 5941 in the "Apply Styles" menu when using within the 
three different list types the first block of entries. It does not 
appear when using the second set of entries. 

This usually means that the styles have not been updated 
in the document you are working on: you are trying to 
style the text with styles that do not yet exist in your 
document. 

See Clause A.4 and 4.3 of the user guide. 

When entering an equation, will the template format the text 
type, italics etc. automatically? 

No. The styles have to be applied to each character 
(except mathematical operators). See this page for 
information about the styles used in MathType: 

https://www.iec.ch/standardsdev/resources/draftingpublica
tions/writing_formatting/IEC_rules/equations.htm 

For detailed information on how to apply the styles, see: 

https://docs.wiris.com/en/mathtype/mathtype_desktop/mor
e_tutorials#fonts_and_styles 

IEC Template user guide, page 5, Subclause 3.2 : How 
should we deal with MathType? Buy it? Rent it on a yearly 
basis? Use the demo version only and let it expire? Or 
update it regularly? 

The preferred tool for editing equations is MathType 
because it produces consistent and repeatable results that 
are fit for publishing, even with complex expressions. To 
benefit from its full functionality, the only option is to 
purchase an annual licence (€40, https://store.wiris.com/). 

It seems that there is no longer the option to have a 30-
day free trial, but rather a refund within 30 days if you are 
not satisfied.  

If you are unable to install MathType for whatever reason, 
you can still use Equation Editor 3.0 if you have access to 
an older version of Word, or Word's built-in equation editor 
available in the Insert tab. 

More details concerning MathType are available here: 

https://www.iec.ch/standardsdev/resources/draftingpublica
tions/writing_formatting/IEC_rules/equations.htm 

IEC Template user guide, page 28, Table B.1: A Style is 
missing for subsubscripts, such as QD1, QD2, … . How 
should a subsubscript in Arial 10 text be formatted? (for an 
example see IEC TR 61431:2020, A.2.3) 

To insert a symbol with a subscript that also has a 
subscript, use Inline equation under Insert equation 
in the Insert elements group, and use MathType to 
insert a subscript after the first subscript. The style 
exists for this in MathType; in this case, the result is: 

2DQ . 

However, when possible, you should use plain text. This is 
because plain text remains searchable; content in 
MathType is not. 

Math type does not seem to work for home office 2016. It could be that your company's IT security policy/antivirus 
forbids the use of dotm files/macros. We have had a 
report of this; you need to check with your IT service. 

Sometimes, the issue can be solved by copying the file 
MathPage.wll (by default in C:\Program Files 
(x86)\MathType\MathPage\32 [or \64 for a 64-bit 
installation]) to Word's startup folder (Windows 10 default 
C:\Users\[user 
name]\AppData\Roaming\Microsoft\Word\STARTUP). 

Math Type does work for me. Is it because it is blocked by 
policy or is it not correctly installed? 
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VERSION ISSUES  

What are the differences between the template posted in 
October (V6.2) and the one posted end July (V6)? 

There are numerous small changes and corrections to 
styles, which are of little importance to people drafting: 
this is why they were not mentioned. 

In the meantime, however, we did add the "Auto cross-
reference" tool, and add the amendment heading styles to 
the headings menu in the Apply styles group, and offer 
drop-down menus to select the correct boilerplates for the 
Normative references and Terms and definitions clauses. 

This is why we waited a couple of months before officially 
presenting the template: so that we were able to present a 
version where any future changes would be significant, 
rather than a list of minute changes to styles. 

From now on, a page will be added at the start of the 
guide to describe the significant changes.  

Concerning future versions, please send suggestions for 
improvement to lmo@iec.ch. 

What about future version updates of the dotm file? 
This template should work with all versions of Word that 
are compatible with dotm files, which means Word 2007 
and later. 

How can I identify the version of the DOTM? My DOTM has 
a different order e.g. on Patent and Normative refs. than 
yours. 

My IEC ribbon bar in insert boilerplate text is not present 
the menu under the button Normative references. Why? 
How can I fix this issue? 

If you hover the mouse over your downloaded file, you 
will see a tag containing the release date. 

Numerous small changes were made in a short period of 
time in the run-up to the webinar; please download the file 
again. Future releases will be documented in the user 
guide. 

Is there a security check against unauthorized changes of 
the DOTM? 

No. If in any doubt, download a new copy of the IEC 
template from the IEC's website: 

https://www.iec.ch/standardsdev/resources/draftingpublic
ations/writing_formatting/IEC_template/iec_template.htm 

Can I check the DOTM that it is identical to the IEC original 
version? 

Some organizations do not allow e-mail or use of macro 
enabled templates (dotm, pptx, etc.) for cybersecurity 
reasons. Has this been considered? 

 

This has been considered, but macros are essential for 
the template to work as intended.  

Note: the template file is not available on the Forms page. 

Is there a tool for version traceability? No 

INSERTING TABLES AND FIGURES 

How do you insert your own (existing) tables? 

You can simply paste into your document and use the 
three table styles in the Apply styles group. For more 
details on table styles, please see Clause B.6 in the user 
guide. 

What if I have a figure with part a and part b? 

Please view the video of the 15:00 Webinar. 

Otherwise, see Clause B.5 of the guide to the template. 
(NB: it should say "all borders should be made invisible" 
rather that "all borders should be deleted".) 

MISCELLANEOUS 

Where can I find the "IEC tools" script to download? 

 
If I want to have a look on the macros, it is asking for a 
password. Can I look it up or does it stay secret? 

It depends what the intent is. If you want to customise the 
IEC tools tab, you need to download "Custom UI Editor 
for Microsoft Office", which is freely available online. 
Open the iecstd.dotm in that piece of software and make 
the changes you want; basic XML knowledge required. 

The VBA modules in the template are password-
protected. If there is a specific part of the code you're 
interested in, contact me at lmo@iec.ch. 
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With the IEC/IEEE dual development standards, which 
formatting system takes precedence? 

According to the Guide to IEC/IEEE cooperation available 
here: https://www.iec.ch/search/?q=IEC/IEEE%20guide, 

the IEC template should be used. 

Can you comment on whether CENELEC will allow use of 
this template for European home-grown standards? 

IEC has not received a request to do so, but if CENELEC 
wishes to use this template, IEC would be happy to seek 
to collaborate with them. 

Does IEC take templated Word submission and convert into 
XML? 

If converted into XML why bother insisting on submissions 
being so correctly formatted/styled - as long as 
understandable, agreed content then that should be ok for 
IEC? 

 

A move to online XML authoring is currently being 
investigated, which will simplify the commenting process 
and facilitate many aspects of drafting. 
 
Until the IEC operates in a full XML workflow, documents 
are converted to XML only after publication. The Word will 
be used for the creation of the PDF and has to be 
correctly styled to produce consistent results in the PDF. 
 
Concerning conversion to XML, properly styled Word 
greatly facilitates the current conversion process. The 
styles are used to determine the tags to apply to the 
different elements of the content. 

Is there a plan/project to improve handling of comments on 
draft standards and the creation of CC documents? 

What is the future of standard preparation? 

Are the standards always going to be PDF files for the next 
few decades? Are there any ongoing attempts to represent 
standards in a "computable language" such that a 
standards file is also a compliance checker (where the 
items being standardized is parametrically represented)? 

As stated above, efforts are currently underway to provide 
TCs with an online collaborative authoring platform which 
is based on XML. From the XML, a variety of formats can 
be generated: PDF, Epub, HTML, etc. Having 
semantically tagged source content will allow us to exploit 
it much easier to whatever desired output format will be in 
the years and decades to come. 

This online authoring environment is designed to 
integrate the wider set of tools and databases which IEC 
operates: experts management, workflow management, 
content databases, etc. It is intended to create a new 
means of in-context commenting and comment resolution 
which should facilitate the process. Inbuilt business rules 
will be able to check for basic compliance with ISO/IEC 
Directives. 

A minimum viable product has been developed and is 
currently being tested. 

Could IEC offer a LaTeX template? This is not planned. A Word-based template was chosen 
because Word is ubiquitous.  

I circulated a Working Draft standard (that I had made using 
the IEC template in Word format) to the members of my 
Maintenance Team. I included line numbers to help with 
commenting. When my team members read the document 
they all saw different line numbers. I believe that later stage 
drafts are always converted to PDF by the TC Secretariat, 
but should earlier stage drafts always be converted to PDF 
before sending out for comments? 

To be certain that everybody sees the content presented 
in exactly the same manner, it is advisable to convert to 
PDF before sending. 

If, for some reason, the margins or the page size are 
changed, the text will be displayed differently, and the line 
numbers will relate to different content. 

The new tools for the template are good but are there any 
layout or formatting changes? No, the same rules for layout apply. 

Why not have a button to insert a typical document layout? 

This is essentially the document outline contained within 
the template file. 

To view the document outline (in other words, to start 
from scratch), please refer to the guide or view the 
relevant part of the webinar again. 

What about special text boxes for "colours" and "stability 
date"?" 

The stability date box is no longer added to documents. If 
the document contains colour, the appropriate content is 
added by the central office. 
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REMARKS 

Please consider the opportunity to add an option for 
inserting titles, annexes and figure/table captions with a 
non-sequential number. This is particularly useful when 
drafting an amendment, that add a new clause/annex/etc. in 
a particular position of the original document. 

To add a title with a non-sequential number, use the same 
tools, but replace the number field with ordinary text. 

Concerning Annexes - it does seem to work standards with 
Part 1/Part 2 system 

This comment seems to be referring to a problem with 
annex heading numbering (e.g. Annex A, Annex B…) that 
has been fixed. Please download the latest template. 

Warning about side-effect of inserting a Figure before the 
Figure-title, or text before a Table-title (if inserting cross-
references to the Figure/Table, the Figure or text will be 
included in the reference).  

The risk has been mitigated with the insertion of a figure 
placeholder. Indeed, if the figure has the style FIGURE-
title instead of FIGURE, or if the figure ends up in the 
same paragraph as the title, the figure itself will be 
included in any references to that figure. 

Useful to highlight "codes" with a grey background. 
To do this: File > Options > Advanced > "Show document 
content" section > Field shading: select Always. This is 
demonstrated in the webinar. 

When using a single landscape page first update header 
before deleting the unused page (in case of page 
renumbering in the future)" 

Landscape pages can be capricious; leave any problems 
with headers/page numbers for the central office's layout 
team to sort out. 

Style "AcRep heading 1" is part of the template, but is not 
used or mentioned in the document (looks like a custom 
style for internal IEC purpose)  
Style "TABLE-centred" looks similar to the original "TABLE-
centered" (looks like a custom style for internal IEC testing 
purpose)" 

Indeed, there are some styles in the list that are not used 
in the drafting of documents. 

Concerning TABLE-centred and TABLE-centered, they 
are identical and exist to ensure that either name is 
recognised by the new template. There was confusion is 
the previous version of the template about the spelling of 
"centred": it said "centred" on the toolbar (GB English), 
but the style was called "centered" (US English). Long 
story, but this is a case of "better to be safe than sorry". I 
might look into this again and see if one of them can be 
deleted. 

I experienced problems using the dotm with existing legacy 
files: Figures collapse to one line. By assigning the style 
FIGURE solved the problem. Other problems occurred 
using non-English WORD e.g. German language. Switching 
to English solved the problem. 

This is correct; figures have to be styled with the style 
FIGURE. 

Table and Figure numbering of Annexes should also 
support to insert a hidden line at the beginning of the Annex 
to avoid the \r1 and handle that. Benefit: if Tables or 
Figures are moved the reset is independent. 

Ways to simplify the numbering have been investigated. 
You may insert a hidden line to reset the numbering. 

For any further questions, please contact the IEC Academy, academy@iec.ch 
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